
Summative Assessment

Objective Type Questions

Subjective Type questions

1. Answer following questions orally:
Ans.

2. Tick ( ) the correct option:
Ans.
3. Fill in the blanks:
Ans.

4. State whether true or false:
Ans.

1. Solve the following :

Ans.

2. Explain the process of printing in the following:
Ans.

i. a.

i. False

i. A dot-matrix printer uses matrix of dots to make up a character. Each
character is produced by printing the most appropriate dot combination.

i. (CPU) : It is the main part of computer, where
the processing of data takes place. The CPU is made up of three units.

ii. Plotters are printer-like devices used for drawing pictures and graphs on
large sheets of paper.

iii. System software is a set of programs designed to operate, control and
execute an application program.

ii. a. iii. a.

i. The number system used for codes in digital computers
.

ii. An 8-bite unit used to code digital data is called a .
iii. Theunitnormallyusedtomeasurecomputerclockspeedis .
iv. The two main components of a computer are and .
v. In the CPU, mathematical calculations are carried out in the unit.

vi. The language was developed for commercial programming,
and the language for scientific work.

vii. In the decimal system 1 + 1 = 2, but in the binary system 1 + 1 =
viii. A Printer prints out a full page at a time.

ix. Total number of unique digits in a hexadecimal number system is .

ii. False iii. False
iv. False v. True vi. True

i. (7) (111) , (13) (1101) , (25) (11001) , (88)

(1011000) ,

(121) (1111001) ,

ii. (111) (7)  , (1011) (11)  , (111000) (56)  , (10101)

(21)  ,

iii.

ii. Inkjet printers operate on the approach. These
printers have print heads that have tiny nozzles. These nozzles spray tiny

Central Processing unit

Binary number
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GHz(Gigaheartz)

Hardware software
ALU
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ink droplets to form the characters.
iii. A laser printer looks like a photocopier. Its principle of operation is also

similar. A laser printer uses the signals sent to it by the computer to
control a laser beam. The beam produces an image of the matter to be
printed on a drum.

Blaise Pascal-Pascaline
Charles Babbage-Babbage engine

ii. The CPU is made up of three units–
a. The control unit– It controls all the parts of the computer.
b. The Arithmetic and Logic Unit (ALU)– All mathematical

calculations and logical function are carried out byALU.
c. The Memory unit– It is used for storing temporary processing results.

Instruction etc.
iii. CPU needs a storage area called the where it sends all the

information. Other devices then read from this buffer at their own speed,
and the CPU continues with further processing, without waiting for the
devices to complete their job.

iv. Secondary storage devices are permanent storage of computer. Hard
drives, flash derives, optical disks, CD–ROMS and DVDs etc. are
secondary storage devices. These are used to store files, instructions,
programs and other things.

v. In impact printers the characters are printed by pressing characters,
against an inked ribbon. These printers print one character at time. Dairy
wheel printer, Line printer and dot matrix printers are impact printers.
inkjet printers and laser printers are impact printers. inkjet printers and
laser printers are Non-impact printers. The print quality is very good in
these printers because characters are formed by tiny ink dots, which are
electronically charged.

vi. Machine language andAssembly language are low level language. These
languages are not easy to learn and execute. FORTRON, CONOL, C++,
JAVA etc. are high level language. HLL are easy to learn and are most
popularly used.

vii. Application software are specific purpose software which are designed to
the need of user. MS word, MS Excel, MS Powerpoint, Tally etc. are
some application software. system software are designed to operate,
control and execute an application program.

viii. Inkjet Printers operate on the continuous stream inkjet approach. These
printers have print heads that have tiny nozzles. These nozzles spray tiny
ink droplets to form the character. The tiny drops merge on the paper, and
can not be separately seen as in a dot-matrix printer. This result in very
good print quality.

ix. It is difficult to decide what to buy. Before you purchase a computer, you
should identify your need.Your need greatly guides your choice.

buffer

3. Answer the following Questions:
Ans. i. John Napier-Napier’s bone.
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Formative Assessment

Do it yourself
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Mail Merge is MS-Word2.

Summative Assessment

Objective Type Questions

Subjective Type questions

1. Answer following questions orally:
Ans.

Ans.
3. Check whether the following statements are True or false:
Ans.
4. Match the following:
Ans.

5. Fill in the blanks:
Ans.

1. Very short answer type questions:
Ans.

i. Mail Merge is an important facility of MS word used to form multiple
individual letters using a data list.

i. a.

i. MS word software has mail merge feature.

ii. Third step allows you to select the data list of those to whom that letter has
to be sent.

iii.
Step 1 : Open the document, select print option in the file menu.
Step 2 : Print dialog box is displayed.
Step 3 : Select the name of printer you are going to use for the hard

output.
Step 4 : Under Page range section, select the pages to be printed.
Step 5 : Under the copies section, type how many copies of each

page are required.
Step 6 : To take the multiple copies of document-page wise deselect

the collate option.
Step 7 : Click OK button to Start printing Job.

ii. c. iii. c. iv. a. v. c.

i. False ii. True iii. False iv. True v. False

i. Main Document a. Viewing individual letters
ii. Address data list b. Print under merge section

iii. Preview letter c. Recipient
iv. Print the letter d. Body of letter

i. is use to create multiple individual letters using a data list.
ii. There are steps in Mail Merge wizard.

iii. Mail Merge Wizard option is available in menu.
iv. Third step Mail Merge allows you to select or create list.
v. Merged document can be printed by clicking option in step 6.

ii. Mail merge feature is available in tools menu.
iii. Letters and Envelops.

2. Tick ( ) the correct option:

Mail merge
6

tools
recipient

print

✓



2. Short answer type questions:
Ans. i. Mail Merge is an important facility of MS Word used to form multiple

individual letters using a data list.

b. A ‘New address list’ dialog box will appear on the screen with entry
fields like, Title, First Name, Last Name, Address Line 1, Address
Line 2, etc. If you want to have only selected fields in your data list,
then click customize button on the dialog box.

Do it yourself

Formative Assessment

ii. Mail Merge Wizard has 6 steps in it. These are:
a. Select document type.
b. Select starting document.
c. Select recipients.
d. Write your letter.
e. Preview your letters.
f. Complete the merge.

iii. a. To create data list of your friends, select the option ‘Type a new list;
under the ‘Type a new list’section click create option.

iv. Step 1 : Open the document, select print option in the file menu.
Step 2 : Print dialog box is displayed.
Step 3 : Select the name of printer you are going to use for the hard

output.
Step 4 : Under Page range section, select the pages to be printed.
Step 5 : Under the copies section, type how many copies of each

page are required.
Step 6 : To take the multiple copies of document-page wise deselect

the collate option.
Step 7 : Click OK button to Start printing Job.

23Computer-7

1. Tick ( ) the correct option:
Ans.
2. Match the following:
Ans.

i. a.

i. Main Document a. Body of letter
ii. Address data list b. Recipient

iii. Preview letter c. Viewing individual letters

✓

ii. a. iii. c iv. a. v. c.

Formative Assessment-I



iv. Print the letter d. Print under merge section

i. Scanner

i. Plotters are printer-like devices used for drawing pictures and graphs on
large sheets of paper.

3. Solve the following:

Ans.

4. Identify the pictures :
Ans.

5. Answer the following questions :
Ans.

i. (7) (111) , (13) (1101) , (25) (11001) , (88)

(1011000) ,

(121) (1111001) ,

ii. (111) (7)  , (1011) (11)  , (111000) (56)  , (10101)

(21)  ,

iii.

ii. Keyboard
iii. LCD
iv. Speaker
v. Mouse

ii. System software is a set of programs designed to operate, control and
execute an application program.

iii. Mail Merge is an important facility of MS Word used to form multiple
individual letters using a data list.

iv. Third step allows you to select the data list of those to whom that letter has
to be sent.

v. Step 1 : Open the document, select print option in the file menu.
Step 2 : Print dialog box is displayed.
Step 3 : Select the name of printer you are going to use for the hard

output.
Step 4 : Under Page range section, select the pages to be printed.
Step 5 : Under the copies section, type how many copies of each

page are required.
Step 6 : To take the multiple copies of document-page wise deselect

the collate option.
Step 7 : Click OK button to Start printing Job.
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Summative Assessment

Objective Type Questions
1. Answer following questions orally:
Ans. i. There are three ways in which you can change the appearance of your

slide making it more attractive and colourful. For this there is an option
called in the Format menu and which can also be selected
from the .

Slide Design
Standard Tool Bar

MS Power Point3.
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ii. We can add bullets to text using the option from
the Format menu or clicking on the icon for Bullets on the tool bar.
Bullets in slides make the text more effective.

iii. We can change the alignment either from the
buttons or by selecting option from the menu. we can
also press the following shortcut keys for the same :

ii. b. iii. a.

i. is gallery of pictures available in Power Point.
ii. To select an image that you have on your hard disk but is not a part of

power point art gallery, click on .
iii. Is the icon for .
iv. There are techniques of changing the appearance of a slide.
v. Apower point file is save with extension name.

vi. you can choose bullets from a variety of symbols which appear when you
click on the button.

vii. A text box can be by clicking on the right hand bottom corner and
dragging it across the screen.

viii. The Header and Footer dialog box has and tabs.
ix. The option is used to convert a picture into a MS office drawing

object.
x. To play music from the beginning of a presentation till the end of

presentation, select option from the
option by right clicking on the sound file option.

xi. is a decorative style of text that can make your presentation
appealing to the eye.

xii. is a special effect used to introduce a slide during a slide
show.

iv. True v. True
vi. True vii. True viii. False ix. False x. True
xi. True xii. False

vi. Text Layout

Bullets and numbering

formatting tool bar
Alignment format

Clipart

import
WordArt

three
ppt

custom
resized

Notes Handouts
ungroup

Edit sound object loop until
stopped
Word Art

Slide Transition

✓2. Tick ( ) the correct option:
Ans.
3. Fill in the blanks:
Ans.

4. State whetherTrue or false:
Ans.

5. Match the following:

Ans.

i. b.

i. False ii. True iii. True

i. Objects

ii. Alt + F + S Saving a slide

iii. Video clip

iv. Sound file

v. Design
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6. Solve the Crossword:
A. B.

Bullets and numbering

inserting a diagram,

inserting a chart

ii. We can add bullets to text using the option from
the format menu or clicking on the icon for Bullets on the tool bar. Bullets
in slides make the text more effective.

iii. For when we click on the object for a diagram a
small dialog box will appear from where we can select the desired
diagram that we want to insert in the slide.

iv. Layout can be selected from slide layout in formatting tool bar. Slide
layout are of two types-Text layout and content an text layout. To fill
background colour. Use the Background option in Insert menu.

v. For , a sample Excel sheet will appear which will have
figures and values that we can change as per your requirements.

vi. Step 1 : choose the option Text Box
from the Insert menu or click
on the Text Box button on
the Drawing Tool bar to insert
a text box. The pointer will
acquire the shape of a+

Step 2 : Take the pointer to the place
where you want to insert the
Text Box

Step 3 : Drag the mouse while left clicking it and move it to the right
hand side in downward motion.

Subjective Type questions
1. Answer the following questions:

Ans. inserting clip Art

OK

i. For images, when we click on the clipart object, a
gallery of power point clip images will appear as show in the figure. To
choose an image from this gallery, simply double click on it or just select
it and click on .
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Step 4 : Release the mouse where you think the size of the text box is
appropriate as per your needs.

Step 5 : Enter the text in the text box.
vii. For from our hard disk, when we click on appropriate

object, a dialog box will appear for us to tell the path to where the pictures
are located on our hard disk. The dialog box will also have a preview pane
for us to view the image that we are selecting. We give the right path and
click or press .

viii. A header and footer can be added by selecting the Header and Footer
option from the View menu.

ix. For inserting music from CD select insert movies and sounds option

play CDAudio Track option.
For inserting movies–

select insert movies and sound option movie from gallery
option.

x. For , when we click on the object it’ll open a small dialog
box asking us the number of rows and columns.

a. Click on option in the menu.
or

b. Select the tool bar button for saving the file
or

c. Press the and then in a sequence.
ii. a. Choose the option form the menu.

or
b. Click on the button on the .

or
c. Press and keys together.

For grouping an object–

Select objects click Draw menu in the Drawing Tool bar select
group.

ii. Just we can insert in a document of MS Word we insert All
shapes in power point presentation. Using the we can
draw object, change colour and use different styles.

ii. If you want music to be played while the slide show is running, insert the
sound file in the first slide (by choosing the appropriate option form the

inserting pictures

insert Enter

inserting tables

save file

Alt F s
Print file

Standard Tool bar

Ctrl P

Autoshapes
Drawing Toolbar

¾®

¾®

¾® ¾®

¾® ¾®

2. How will you do the following:
Ans.

3. How do you :
Ans.

4. Answer the following questions :
Ans.

i.

i. To apply ungrouping option to picture, select the picture by clicking on it
and select the option by clicking on it and select the option ungroup from
the Draw menu on the Drawing Tool Bar.

i. Clipart is a collection of pictures available in Power point, Word and
Excel. Adding images to a power point presentation makes the
information more valuable and a lot more interesting for an audience.
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insert menu) because the music begins only where you insert the sound
object.

iii. For adding word Art, Click on the word Art icon on the Drawing Tool bar
or select the word Art option from picture option of insert menu.

Animation effect can be choosen by clicking format menu slide

Design Animation Scheme.
iv. Transition is a special effect used to introduce a slide during a slide show.

To introduce transition effect in a slide show. Select the slide you want to
subject to transition. Select slide transition option from the slide show
menu.

v. By using this feature of slide show, each slide will appear for particular
time duration and disappear for the next to appear.

vi. The difference between an animation effect and transition effect is that in
Animation effect, the contents of the slide are introduced with special
effect whereas in a transition effect, the complete slide is introduce with a
special effect.

¾®

¾®

Formative Assessment

Do it yourself

QBASIC Programming Statements4.

Summative Assessment

Objective Type Questions

Subjective Type questions

1. Answer following questions orally:
Ans.

2. Tick ( ) the correct option:
Ans.
3. Fill in the blanks:
Ans.

1. Find out the errors in the following programs:
Ans.

i. STEP statement is given to specify the step value. If not specified, STEP
defaults to one.

i. b. ii. a. iii. b.

i. CLS

3

ii. A counter variable is used to control execution of a Do
WHILE........LOOP.

iii. Exit command is used to come out of a loop before the expected number
of executions. EXIT command is used followed by either FOR or DO.

i. FOR......NEXT is type of QBASIC statement.
ii. is used to end DO loop

iii. works similar to DO.......WHILE.
iv. is used to repeat certain steps a fixed number of times.
v. The DO......LOOP can be used either with WHILE statements or

statement.

repetitive
LOOP
While......Wend
Step value

wend
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ForA= 1 to 10 STEP1
PRINTA
NEXTA

For X = 10 to 1 STEP- 1
PRINT X
NEXT X

ii. Output-
1 1
5 2

10 3
15 4
20 5
25 6
30 7
35 8
40 9
45
50

i. Sometimes there is a need to repeat a set of statements more than once
based on a certain condition. This process of repetition is called loop or
iteration in programming.
The following are the loops available in QBASIC
Do WHILE..............LOOP
FOR.............NEXT
WHILE..........WEND

ii. FOR............NEXT structure is used when we want to perform a loop a
specific number of times it uses a counter variable which is incremented
or incremented with each repetition of the loop.

To print numbers from 1 to 5
Input- CLS Output- 1

FORA= 1 to 5 2
PRINTA 3
NEXTA 4

5
iii. The purpose of Do.........LOOP and WHILE.............WEND is similar

except for the syntax. if the condition is placed at the end of loop, the end
of loop is executed at least once.

To generate multiples of 5 from 5 to 50
Input- CLS Output- 5

LET NUM = 5 10
WHILE NUM < = 50 15
PRINT NUM 20

Example-

Sample Program:

ii. CLS

i. Output-
2. Give the output of the following programs:
Ans.

3. Answer the following questions:
Ans.



NUM = NUM + 5 25
WEND 30

35
40
45
50

iv. A Do WHILE........LOOP is performed as long as the condition being
tested is true. A DO..........UNTIl LOOP executes the statements until the
condition is true.

v. Exit command is used to come out of a loop before the expected number
of executions. EXIT command is used followed by either FOR or DO.

To exit after 3 while printing 1 to 5
Input- CLS

FORM = 1to 5 Output:- 1
PRINT M 2
IFM = 3 THEN EXIT FOR 3
NEXT M

Sample Program:

Formative Assessment

Do it yourself

30Computer-7

1. Tick ( ) the correct option:
Ans.
2. Match the following:

Ans.

3. Find out the errors in the following programs:
Ans.

3

i. b. ii. a. iii. b. iv. a.

i. Objects

ii. Alt + F + S Saving a slide

iii. Video clip

iv. Sound file

v. Design

i. CLS

v. b.

vi. Text Layout

FORA= 1 to 10 STEP= 1
PRINTA
NEXTA

ii. CLS
For X = 10 to 1 STEP-1
PRINT X
NEXT X

Formative Assessment-II



4. Identify the pictures :
Ans.

5. Answer the following questions :
Ans.

i. Insert Table ii. Flow Diagram
iii. FONT iv. Bullets and Numbering
v. Line Spacing

i. We can add bullets to text using the option from
the format menu or clicking on the icon for Bullets on the tool bar. Bullets
in slides make the text more effective.

ii. We can change the alignment either from the
buttons or by selecting option form the menu. We
can also press the following shortcut keys for the same.

iii. STEP statement is given to specify the step Value. If not specified. STEP
defaults to one.

iv. A counter variable is used to control execution of a DO
WHILE.......LOOP.

v. Exit command is used to come out of a loop before the expected number
of executions. EXIT command is used followed by either FOR or DO.

Bullets and numbering

formatting tool bar
Alignment Format

Summative Assessment-I

1. Fill in the blanks :
Ans.

2. Write true of False:
Ans.
3. Explain the process of printing in the following:
Ans.

Ans.

i. False

i. A dot-matrix printer uses matrix of dots to make up a character. Each
character is produced by printing the most appropriate dot combination.

1. Output 2. Output
1 1
5 2

10 3
15 4
20 5

i. An 8-bit unit used to code digital data is called .
ii. Mail Merge Wizard option is available in menu.

iii. is a gallery of pictures available in Power Point.
iv. A printer prints out a full page at a time.
v. is used to end DO loop.

ii. False iii. False iv. True v. True

ii. Inkjet printers operates on the approach. These
printers have print heads that have tiny nozzles. These nozzles spray tiny
ink droplets to form the character.

iii. A laser printer looks like a photocopier. Its principle of operation is also
similar. A laser printer uses the signals sent to it by the computer to
control a laser beam. The beam produces an image of the matter to be
printed on a drum.

Byte
Tools

Clipart
Laser

LOOP

continuous-steam inkjet

4. Give the output of the following programs:
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25 6
30 7
35 8
40 9
45
50

i. Secondary storage devices are permanent storage of computer. Hard
drive, Flash drives, optical disks, CD-ROMs and DVDs etc. are
secondary storage devices. These are used to store files, instructions,
programs and other things.

5. Answer the following questions :
Ans.

ii. Mail Merge is an important facility of MS Word used to form multiple
individual letters using a data list.

iii. Sometimes there is a need to repeat a set of statements more than once
based on a certain condition. This process of repetition is called loop or
iteration in programming. The following are the loops available in
QBASIC
DO WHILE..........LOOP
FOR............NEXT
WHILE............WEND

iv. CPU needs a storage area called the where it sends all the
information. Other devices then read from this buffer at their own speed,
and the CPU continues with further processing, without waiting for the
devices to complete their job.

v. For adding word Art, Click on the word Art icon on the drawing tool Bar
or select the word art option from picture option of insert menu.
Animation effect can be choosen by clicking–

FORMAT MENU SLIDE DESIGN ANIMATION SCHEME

buffer

¾® ¾®

QBASIC—Graphics and Sound5.

Summative Assessment

Objective Type Questions
1. Answer following questions orally:
Ans. i. Resolution of the screen or the image displayed is measured in terms of

the pixels present horizontally and vertically on a screen. For example,
resolution 320X200 for an image would mean 320 pixels in a horizontal
direction and 200 pixels in vertical direction.

ii. The different screen modes allow different types of display. The two
types of modes are and .

iii. The PSET command is used to display pixels on the screen PSET
command is effective only after you have given SCREEN command

text mode graphics mode



2. Tick ( ) the correct option:
Ans.
3. Match the following:
Ans.

4. Fill in the blanks:
Ans.

1. What do the following commands do? Write an example of each. Can
these be used with the SCREEN mode 0:

Ans.

Example:

3

i. a.

i. The BEEP command produces a beep sound that lasts for about half
second.

Sound 500, 25
v. The PSET command is used to display pixels on the screen. PSET

command is effective only after we have given SCREEN Command.

vi. PAINT command is used to paint a particular point with the specified
colour. The command has coordinates that tells Q BASIC where to start.

Subjective Type questions

ii. d. iii. a.

i. SCREEN 0 e. Changes to text mode
ii. COLOR 4 c. Sets the colour to red

iii. PSET command b. Sets the colour of the pixel
iv. SOUND 20, 5 a. Produces sound
v. LNE command d. draws a box or line

i. and are the two modes of screen in QBASIC.
ii. There are a total of colours to be used with COLOR command.

iii. command produces sound of a specific frequency for a specific
duration from the PC speaker.

iv. and can be drawn by using LINE command.
v. and are the two parametres used with command.

PRINT “You should be courageous in actions”
BEEP
PRINT “However,You must also be wise”
BEEP

ii. LINE command is used to draw a line between two specified coordinates.
to display a red line on the screen starting from the (10, 22)
cordinates to (35, 30) cordinates.

SCREEN 9
LINE (10, 22) - (35, 30), 4

iii. COLOR Command is used to change the colour of the screen and the text.
Input- CLS

COLOR 2
PRINT “PLANT MORE TREES”

The screen will appear black and the text will appear green.
iv. Sound command produces sound of a specific frequency for a specific

duration from the PC Speaker.

To display a pixel at the cordinates (50, 15) in colour
number 2, i.e., Dark Green colour.
SCREEN 10
PEST (50, 15), 2

Text Graphics
16

Sound

Square rectangle
Frequency ticks SOUND

Example-

Example-

Example:

Output-

Example-

Command-
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To display a circle the screen starting from the (160, 100)
coordinates radius 20 with border colour cyan–
SCREEN 1
CIRCLE (160, 100), 20
PAINT (160, 100), 2, 3

i. QBASIC is not a graphic-oriented programming language. It was meant
to be a learner’s language for basic programming techniques. However,
with the help of some of its functions, we can achieve some level of
graphic quality while keeping in mid the language’s power.

ii. The SCREEN command is used to set the screen attributes. The screen
attributes is always a number.

iii. COLOR command is used to change the colour of the screen and the text.
You have to specify a colour number which will be followed by the text in
the PRINT statement.
Syntax
COLOR [number]
Where number ranges from 1 to 15 for a specific colour.

iv. The Computer screen that you see consists of hundreds of picture
elements known as pixels. In other words, a is the smallest possible
element of an image of the screen.

v. Line command is used to draw a line between two specified coordinates.
we can also draw a square or a rectengle by taking the diagonal
coordinates.

To make a box with white color.
SCREEN 1
LINE (10, 20) - (100, 50)m 15, B

CIRCLE command is used to draw a circle of a specific radius at given
coordinates. This command will be effective only after using the
SCREEN command to get the display graphics mode.

To display a blue circle at the 20.05 coordinates with radius 5
SCREEN 1
CIRCLE (20, 25), 5, 1

Example-

pixel

Example-

Example-

2. Answer the following questions:
Ans.

Formative Assessment

Do it yourself

Internet and WWW6.

Summative Assessment

Objective Type Questions
1. Answer following questions orally:
Ans. i. AWeb browser is software which understand HTML code or instructions

written in an HTMLdocument and displays parts of a Web Page.



ii. A URL is the Internet address for a web document or other file. A typical
URLlooks like this:
http://www.yahoo.com

iii. Awebsite consist fo a main page called the Homepage.

i. Every website has a address.
ii. The is a collection of websites.

iii. allows you to view web pages.
iv. is an acronym for Hyper Text Transfer Protocol.
v. and are the two famous internet Browsers.

i. a. Link to other pages
ii. Websites b. Lycos, Google

iii. Index c. Web Browser
iv. Hyperlink d. Home Page
v. Search Engines e. Acombination of web pages

A website is a collection of web pages. A website
may consist of a single web page or may comprise multiple
interconnected web pages.

ii. HTTP means Hyper Text Transfer protocol. HTTP is simply a procedure
used to transfer information from a WWW page. users of the web retrieve
documents from servers. FTP means file transfer protocol. FTP allows us
to download a file and transfer it to our hard disk.

iii. A hyperlink connects the web pages with each other. Some hyperlinks
connect pages on website to pages on other websites. A website consists

URL
WWW

Web Browser
HTTP
Internet Explorer Fire Fox

2. Tick ( ) the correct option:
Ans.
3. Fill in the blanks:
Ans.

4. Write true of False:
Ans.
5. Match the following:
Ans.

6. Solve the crossword:
Ans.

1. Differentiate between:
Ans.

3

i. b. ii. a. iii. a.

i. True ii. False iii. True iv. True v. False

i. A web page is an interactive document that stores information and can be
viewed on the internet.

Subjective Type questions
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of a main page called Home page. It is usually the first page on website
and consists of an index which links us to other pages.

i. A web browser is software which understands HTML code or
instructions written in on HTML document and displays parts of web
pages.

Internet Explorer, Mozila Firefox.
ii. Search Engines are used to access the websites by typing in key words.

Google, yahoo, MSN etc are some common search engines Google is the
most popular search engine.

iii. WWW-World Wide Web is a collection of websites. Webserver- A
webserver is the heart of internet. It stores information that we browse on
the internet.
URL- Uniform resource Locator is the internet address of a website.
Search Engine- Access a search Engine which lets us access sites by
typing in keywords.
HTML- Hyper TexT Mark up Language is the computer’s language used
to create web pages.

iv. a. While logged on to the web, type http://www.google.co.in (for
example) in the URLentry field. Press ENTER on the keyboard.
b. Type one or more words pertaining to information you’d like to lacate
on the web. For example, you want to find information on the temples of
India. So you will type India+ Temples in the text box.
c. Click on the SEARCH button to the right of the entry field, or press
ENTER on the keyboard.
d. After a few seconds, google will show a list of website links that
match your search criteria.
e. Scroll down the page and select the website link to a page that you’d
like to explore and click on the hyperlink.

Example-

2. Answer the following questions:
Ans.

Formative Assessment

Do it yourself
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1. Tick ( ) the correct option:
Ans.
2. Differentiate between:
Ans.

3

i. d.

i. A web page is an interactive document that stores information and can be
viewed on the internet.

ii. a. iii. b. iv. a. v. a.

A website is a collection of web pages. A website
may consist of a single web page or may comprise multiple
interconnected web pages.

ii. HTTP means Hyper Text Transfer protocol. HTTP is simply a procedure
used to transfer information from a WWW page. users of the web retrieve
documents from servers. FTP means File Transfer protocol. FTP allows

Formative Assessment-III



us to download a file and transfer it to our hard disk.
iii. A Hyperlink connects the web pages with each other. Some hyperlinks

connect pages on website to pages on other websites. A website consists
of a main page called Home page. It is usually the first page on website
and consists of an index which links us to other pages.

i. SCREEN 0 e. Changes to text mode
ii. COLOR 4 c. Sets the colour to red

iii. PSET command b. Sets the colour of the pixel
iv. SOUND 20, 5 a. Produces sound
v. LNE command d. draws a box or line

ii. ‘Save’the web page
iii. Ted Nilson
iv. Tim Burners
v. PRINT the web page

i. The different screen modes allow different types of display. The two
types of modes are and .

ii. The PSET command is used to display pixels on the screen PSET
command is effective only after you have given SCREEN command.

iii. A web browser is software which understands HTML code or
instructions written in an HTML document and displays parts of a web
page.

iv. A URL is the internet address for a web document or other file. A typical
URLlooks like this:
http://www.yahoo.com

v. Awebsite consists of a main page called the Homepage.

5. Answer the following questions :

text mode graphics mode

3. Match the following :
Ans.

4. Identify the pictures :
Ans.

Ans.

i. Wikipedia

HTML-The Language of Web Pages7

Summative Assessment

Objective Type Questions
1. Answer following questions orally:
Ans.

2. Tick ( ) the correct option:
Ans.
3. Fill in the blanks:
Ans.

i. Commands in HTMLare called tags.

i. a. ii. c.
3

ii. The files stored on the servers, which can be accessed by the internet
users are called web sites.

iii. The text attributes is used to set the colour of the text in the document.

iii. a.

i. HTMLstands for .Hyper text mark up language
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ii. HTML elements that include both on ON tag and on OFF tag are called
elements.

iii. HTML elements that include only on ON tag and no OFF tag are called
tag.

iv. An HTMLdocument can have or as its extension.
v. HTMLdocuments have two distinct parts, and .

vi. The attributes allows you to specify a colour to be used as
background in the Web page.

i. True ii. True iii. True iv. False
v. False vi. True vii. True viii. True

ii. Web pages are text documents having HTML commands. HTML defines
a set of common styles for web pages. HTML is a cross-plat form
language, i.e., HTML documents can be used on any type of computer or
platform like Macintosh computer, IBM computer, Unix, Windows etc.

iii. The elements that contain both the ON and OFF tags (also known as
opening and closing tags) are container Elements.

<TITLE> My First page </TITLE> Empty elements have
only an UN tag and no off tag.
Empty elements have only an on tag and no off tag.
<HR> Welcome in HTML.

iv. Document tags are needed for every HTML document. These tags are
used to describe the over all structure of the page and also provide the
heard information. An HTML document is divided into two sections- the
Head section and the Body section. HTML, Head, Title an Body are four
basic document tag.

v. Some tags have attributes that further proved options for the tag, e.g., the
font tag has a colour attribute that allows you specify a colour for the
particular text. The Body element can have the following five attributes–
a. background, b. bg color, c. text, d. link, e. alink

<HTML>
<HEAD>
<TITLE> WELCOME TO HTML</TITLE>
</HEAD>
<BODYbg color = “Aqua” text = “Red”>
This is a web page. </BODY>
</HTML>

container

empty
htm html

Title Body
bg colour

Example-

Example-

Exmaple-

4. State the following Statements as True or False:
Ans.

1. Answer the following questions:
Ans.

Subjective Type questions

i. HTML is the acronym for Hyper text Mark up language. It is a computer
language that is used for creating Web pages. HTML is scripting
language (or mark up language) which differs completely from
programming languages.

Do it yourself

Formative Assessment
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Continue With HTML8.

Summative Assessment

Objective Type Questions

Subjective Type questions

1. Answer following questions orally:
Ans.

2. Tick ( ) the correct option:
Ans.
3. Fill in the blanks:
Ans.

4. State the following Statements as True or False:
Ans.

1. Answer the following questions:
Ans.

Example:

i. To insert a blank space special HTML code enbsp has to be added to the
document.

i. a.

i.

<HTML>

3

<HTML>
<HEAD>
<TITLE> BLANK SPACES </TITLE>
<BODY>

Roll No nbsp; nbsp; nbsp Name
</BODY>
</HTML>

ii. To Start a new line without starting a new paragraph, the empty element
or is used. Like any other empty tag this also does not

act on a block of text. It simply breaks the text wherever it is encountered
and starts the remaining text at the left margin in the next line.

iii. Text in a page is divided with the help of headings an subheadings to
make it easy to understand and follow. or < > is used
to display headings in your Web page.

ii. c. iii. a.

i. The full form of HTMLis .
ii. There are different levels of headings in HTML.

iii. The align attributes can be added to the tag to center, left or right
align the heading.

iv. Blank spaces can be added in the text by using the code.
v. To start a new line, the empty element is used.

i. True ii. False iii. True iv. True v. True vi. False

<H? align = label>..........</H?>
Where label can take the
values left, center or right.

<HEAD>
<TITLE> HEADING </TITLE>
</HEAD>
<BODY>

e e e

Break tag <BR>

Heading tag H? tag

Hyper text Mark up language
six

Heading

nbsp
<BR>

Syntax :

e



<H1 align = right> WELCOME </H1>
<H1 align = center> WELCOME </H1>
<H1 align = left> WELCOME </H1>
</BODY>
</HTML>

<FONT Face = name>
Where name stands for the name of a font.

b. - <FONT size = val>
Where ‘Val’ stands for the value that the size attribute can
take.

iii. To bolden italicize, underline or strike though text, the container
elements < >, < >, < > or < > can be used.

<HTML>
<HEAD>
<TITLE> Text style </TITLE> </HEAD>
<BODY>
<B> <I> HELLO WORLD </U>
<STRIKE> HELLO WORLD </STRIKE>
</BODY>
</HTML>

iv. Text can be made to appear in the center by using the container element

<CENTER>.........</CENTER>
<HTML>
<HEAD>
<TITLE> CENTER TEXT </TITLE></HEAD>
<BODY>
<H1>
<CENTER> WELCOME TO HTML
</CENTER>
</H1>
<BODY>
</HTML>

syntax-

syntax

B I U Strike
Example:

<CENTER>
Syntax :
Example:

ii. a. The font of text can be changed by using the container element
<FONT>. The <FONT> tag can take the attributes face and size.

Do it yourself

Formative Assessment
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Introduction to Photoshop9.

Summative Assessment

Objective Type Questions

Subjective Type questions

1. Tick ( ) the correct option:
Ans.
2. State the following Statements as True or False:
Ans.

1. Differentiate between:
Ans.

Ans.

3

i. c.

i. The smudge tool spreads colour pixels across the area of an image. The
Blur tool is used to blur the hard areas of an image.

i. Pixels are dots of colour arranged on a regular grid in a pattern
representing the form to be displayed

ii. b. iii. c. iv. b. v. c. vi. c

i. False ii. True iii. True iv. False
v. True vi. True vii. False

ii. The paint brush tool is used for applying brush strokes of an image. The
Air brush tool is used to soften the edges of an image.

iii. A regular Lasso tool makes a free-hand selection of any shape. The
polygonal Lasso tool makes irregular geometric selections.

ii. Resolution refers to the number of coloured dots-per-inch (dpi) or pixels-
per-inch. This value determines the quality of the output obtained. An
image with a higher resolution is of a better quality.

iii. The tool allows us to make free-had selections. This tool also has
three options- the Simple, the polygonal and the magentic lasso.
The Simple Lasso is a free-hand selection tool with only straight lines.
This doesn’t have any key nodes.
The Polygonal Lasso has a both straight and curved line selections. This
also allows us to specify the key nodes.
The Mangetic Lasso attracts the outline of the Image and specifies the
key nodes automatically. We can also specify our own key nodes.

iv. The Magic Wand is a different kind of selection tool. Adjacent pixels
having similar colour values will be selected by this tool. This enables us
to cut or copy the foreground objects, (for example, the duck) from the
background (the water and leaves).

v. In Photoshop, we can work in different layers. Every object we create in
the image is made in a different layer. If we want to modify any part of the
image. We can simply select that layer and make the changes, without
affecting the rest of the image. The layer menu has options to create,
modify and manipulate layers.

vi. a. The full form of TIFF is Tag Image File Format. This file
format gives us a high-quality image but has a much bigger file size.

b. The full form of GIF is Graphical Interchange Format. It
is one of the three most common graphic formats used for web
publishing.

c. Documents created in this kind of format can be read

2. Answer these questions in brief:

Lasso

TIFF (.tif) :

GIF (.gif) :

PDF (.pdf) :
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across, different programs. The full form of PDF is portable
Document Format, and is anAdobeAcrobat file.

Formative Assessment

Do it yourself

1. Tick ( ) the correct option:
Ans.
2. Give the syntax for the following:
Ans.

3. Identify the pictures :
Ans.

4. Answer the following questions :
Ans.

3

i. c.

i. <FONT face = name> ..................</FONT>

i. <BR> tag for New line

i. Website i s collection of web pages.

ii. a. iii. a. iv. c. v. a.

ii. <FONT size = val> ..................</FONT>

ii. Back ground colour
iii. Open HTMLfile iv. Heading andAlignment
v. To save HTMLfile

ii. The next attributes is used to set the colour of the text in the document.

iii. To insert a blank space special HTML code nbsp has to be added to the
document.

<HTML>
<HEAD>
<TITLE> BLANK SPACES </TITLE>
<BODY>

Roll No nbsp; nbsp; nbsp Name
</BODY>
</HTML>

iv. To start a new line without starting a new paragraph, the empty element
or is used. Like any other empty tag this tag also does not

act on a block of text. It simply breaks the text wherever it is encountered
and starts the remaining text at the leftmargin in thenext line.

v. Text in a page is divided with the help of headings and subheadings to
make it easy to understand and follow. or is used
to display headings in your Web page.

e

e e e

Example:

Break tag <BR>

Heading tag <H?> tag

Formative Assessment-IV
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1. Fill in the blanks :
Ans. i. and are the two modes of screen in QBASIC.

ii. There are a total of colours to be used with COLOR command.
iii. Every Website has a address.
iv. HTMLstands for .
v. To start a new line, the empty element is used.

Text Graphics
16

unique
Hyper text Mark up language

<BR>

Summative Assessment-II
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2. Write true of False:
Ans.
3. Differentiate between:
Ans.

4. Define the following file formats:
Ans.

Ans.

6. Answer the following questions :
Ans.

i. True

i. HTTP means Hyper Text Transfer protocol. HTTP is simply a procedure
used to transfer information from a WWW page. users of the web retrieve
documents from servers. FTP means file transfer protocol. FTP allows us
to download a file and transfer it to our hard disk.

i. The BEEP command produces a beep sound that lasts for about half
second.

ii. False iii. False iv. True v. False

ii. A hyperlink connects the web pages with each other. Some hyperlinks
connect pages on website to pages on other websites. A website consists
of a main page called Home page. It is usually the first page on website
and consists of an index which links us to other pages.

iii. The smudge tool spreads colour pixels across the area of an image. The
Blur tool is used to blur the hard areas of an image.

iv. The paint brush tool is used for applying brush strokes of an image. The
Air brush tool is used to soften the edges of an image.

v. A regular Lasso tool makes a free-hand selection of any shape. The
polygonal Lasso tool makes irregular geometric selections.

i. The full form of TIFF is Tag Image File Format. This file
format gives us a high-quality image but has a much bigger file size.

ii. The full form of GIF is Graphical Interchange Format. It is
one of the three most common graphic formats used for web publishing.

iii. Documents created in this kind of format can be read across,
different programs. The full form of PDF is portable Document Format,
and is anAdobeAcrobat file.

PRINT “You should be courageous in actions”
BEEP
PRINT “However,You must also be wise”
BEEP

ii. The PSET command is used to display pixels on the screen. PSET
command is effective only after we have given SCREEN Command.

To display a pixel at the cordinates (50, 15) in colour number
2, i.e., Dark Green colour.
SCREEN 10
PEST (50, 15), 2

i. The Computer screen that you see consists of hundreds of picture
elements known as pixels. In other words, a is the smallest possible
element of an image of the screen.

ii. a. While logged on to the web, type http://www.google.co.in (for
example) in the URLentry field. Press ENTER on the keyboard.

b. Type one or more words pertaining to information you’d like to locate
on the web. For example, you want to find information on the temples

TIFF (.tif) :

GIF (.gif) :

PDF (.pdf) :

5. What do the following commands do :

Example-

Example-

Command-

pixel



of India. So you will type India+ Temples in the text box.
c. Click on the SEARCH button to the right of the entry field, or press

ENTER on the keyboard.
d. After a few seconds, google will show a list of website links that

match your search criteria.
e. Scroll down the page and select the website link to a page that you’d

like to explore and click on the hyperlink.
iii. Web Pages are text documents having HTML commands. HTML defines

a set of common styles for web pages. HTML is a cross plat form
language, i.e., HTML documents can be used on any type of computer or
plat form like Macintosh computer, IBM Computer, Unix, Windows etc.

iv. To bolden italicize, underline or strike though text, the container
elements < >, < >, < > or < > can be used.

<HTML>
<HEAD>
<TITLE> Text style </TITLE> </HEAD>
<BODY>
<B> <I> HELLO WORLD </U>
<STRIKE> HELLO WORLD </STRIKE>
</BODY>
</HTML>

v. Text can be made to appear in the center by using the container element

<CENTER>.........</CENTER>
<HTML>
<HEAD>
<TITLE> CENTER TEXT </TITLE></HEAD>
<BODY>
<H1>
<CENTER> WELCOME TO HTML
</CENTER>
</H1>
<BODY>
</HTML>

B I U Strike
Example:

<CENTER>
Syntax :
Example:
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